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This document outlines how to prepare articles for submission. We recommend you read 

these guidelines in full before submitting your article or making an article proposal. 

Authors are also advised to read the separate journal policy document here: 
http://www.future-science.com/page/authors.jsp 
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Clinical Investigation is dedicated to systematic coverage of the methodology, 

progress and outcomes of clinical trials. As a peer-reviewed, monthly publication 

Clinical Investigation provides a forum for the rapid publication of original research 

and critically reviews the latest developments in medical research, from Phase 1 trials 

through to post-marketing studies and pharmacoeconomic research. 

The fully-loaded costs involved in bringing a new medicine to market can be as high 

as $1.3 billion dollars, and much of this cost is incurred during clinical evaluation. 

Although dozens of new therapeutic entities enter clinical use each year, only one of 

every 10,000 potential medicines survives the development and approval process. The 

process of clinical development is therefore highly expensive, involved and complex, 

with huge demands placed on investigators to deliver robust, reproducible data and to 

meet the exacting requirements of regulatory authorities. 

Clinical Investigation assimilates the wealth of information resulting from the clinical 

development of new medicines into concise yet comprehensive formats. The journal 

addresses contemporary issues in clinical drug development and methodology, and 

also provides a platform for the rapid publication of new drug data from human 

studies. Coverage spans all therapeutic areas and relates to conventional small-

molecule drugs as well as biotech-derived therapeutic entities, including vaccines, 

monoclonal antibodies, antisense, cell and gene therapies and recombinant proteins. 

The journal publishes review articles, original papers, perspectives, commentaries, 

meeting reports, news, views and more. 

Principal themes include: 

 Clinical study design and methodology  

 Overviews of the clinical progress of new drugs or drug classes  

 Clinical progress for specific diseases or therapeutic areas  

 Findings in Phase I to IV clinical studies  

 Healthcare outcomes and pharmacoeconomics  

 Patient stratification and individualised therapies  

 Commentary on trials in progress  

 Drug safety issues and adverse event monitoring  

 Biomarkers in clinical trials  

 Regulatory issues  

 Clinical trial data management and statistics  

 

Clinical Investigation provides a systematic program of peer-reviewed coverage 

relating to the clinical evaluation of new and established therapies. The audience for 

Clinical Investigation includes clinical investigators, healthcare decision makers, 

formulary managers, clinicians, regulatory personnel and medical affairs 

professionals. Future Science articles have been engineered specifically for the time-
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constrained professional. The structure is designed to draw the readers’ attention 

directly to the information they require. 

 

Authors should consult the below checklist before formatting their manuscript. 

Further details on all article sections are given in ‘Article Sections’.  

 
        Sections                                              

 

 

 

 

 

Article type 

Word limit 

(excluding 

abstract and 

references) 

Abstract 

 

 

Key 

words 

 

Future 

Perspective 

and Executive 

Summary 

Reference 

limit 

Figures and 

tables 

permitted 
(Combined limit 

of eight in total – 
additional will be 

made 

supplementary 
(online-only)) 

Supporting 

cover letter 

 

Editorial 1500       20     

Opinion 1500       20     

Commentary 3000       20     

Letter to the 

Editor 

1500       20     

Conference 

Report 

3000       20     

Research 

Update 

3000       20     

Special Report 5000       50     

Perspective  8000       150     

Review  8000       150     

Research 

Article 

8000       150     

Preliminary 

Communication 

5000       50      

Methodology 5000       50     
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Clinical Investigation publishes a range of article types, descriptions of which are 

outlined below. Authors are encouraged to consult the ‘At-a-glance article 

formatting checklist’ for details on word counts and other formatting requirements.  

Editorials, Opinions and Commentaries 

 

Editorials are short articles that provide an insight into, or snapshot of issues of topical 

importance to the journal’s target audience or researchers and other professionals. The 

intention is that the article should offer an expert perspective on a topic of recent 

interest. More detailed discussions can take the form of Commentary articles. 

Opinion articles should typically be informed, agenda-setting and authoritative. If 

addressing a problem, they should also present coherent argued solutions. They can 

address issues relating to scientific research, or peripheral areas of debate affecting 

industry and academia of concern to the journal’s scope. 

Published example: 

Billingham L, Malottki K, Steven N. Small sample sises in clinical trials: a 

statistician’s perspective. Clin. Invest. 2(7), 655–657 (2012). 

www.future-science.com/doi/pdf/10.4155/cli.12.62 

Conference Reports 

 

Conference reports aim to summarise the most important research presented at a 

recent relevant meeting or event. It is not usually feasible to attempt comprehensive 

coverage of the conference; authors should therefore focus on those presentations that 

are most topical, interesting or thought-provoking. 

 

Published example: 

Fallon JK, Gulley JL. World Vaccine Trials Congress 2012. Clin. Invest. 2(8), 765–

767 (2012).   

 

www.future-science.com/doi/pdf/10.4155/cli.12.69 

Research Updates 

 

Research Updates aim to summarise the development and undertaking of a clinical 

research network or initiative, discussing how the network/imitative was set up, 

highlighting what progress it has made to date and presenting new avenues for future 

research and/or collaboration. 

 

http://www.future-science.com/doi/pdf/10.4155/cli.12.62
http://www.future-science.com/doi/pdf/10.4155/cli.12.69
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Published example: 

Gnant M, Piccart-Gebhart M,  Goldhirsch A et al. Developing an international 

network for breast cancer research: the BIG experience. Clin. Invest. 1(5), 623–628 

(2011). 

 

www.future-science.com/doi/pdf/10.4155/cli.11.44 

Reviews 

 

Reviews aim to highlight recent significant advances in research, ongoing challenges 

and unmet needs; authors should be concise and critical in their appraisal of the 

subject matter, and strive for clarity. The focus should be on key, defining 

developments rather than providing a comprehensive literature survey. Reviews 

should provide balanced coverage of the field and not focus predominantly on the 

author's own research. Authors are encouraged to include their own perspective on 

current trends and future directions.  

 

Please note two types of Review article feature in Clinical Investigation:  

 

Clinical Trial Outcomes articles aim to highlight recent significant advances in 

clinical research, ongoing challenges and unmet needs, and could be in the format of a 

review of a specific condition/disease, a therapeutic class, a collection of trials/single 

trial or an individual drug/therapy. 

 

Clinical Trial Methodology articles present recent findings and developments in the 

design and undertaking of clinical research. Authors should critically assess the latest 

available literature, discussing new considerations in the design, performance, 

analysis, reporting and interpretation of clinical trials and how these new approaches 

may improve clinical investigation. 

 

Published example: 

Karikios DJ, Boyer MJ.  Irreversible EGFR inhibitors in advanced non-small-cell lung 

carcinoma: rationale and clinical evidence. Clin. Invest. 2(3), 317–325 (2012). 

 

www.future-science.com/doi/pdf/10.4155/cli.12.7 

Alhathal N, Al-Qaoud T Carrier S. Considerations in the design of clinical trials for 

erectile dysfunction Clin. Invest. 2(7), 733–745 (2012). 

www.future-science.com/doi/pdf/10.4155/cli.12.54 

Perspectives 

 

Perspectives have the same basic structure and length as review articles; however, 

they should be more speculative and forward-looking, even visionary. They offer the 

author the opportunity to present criticism, address controversy or provide a personal 

http://www.future-science.com/doi/pdf/10.4155/cli.11.44
http://www.future-science.com/doi/pdf/10.4155/cli.12.7
http://www.future-science.com/doi/pdf/10.4155/cli.12.54
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angle on a significant issue. Authors of perspectives are encouraged to be opinionated, 

with all positions concisely and clearly argued and referenced. Referees will be 

briefed to review these articles for quality and relevance of argument only. They will 

not necessarily be expected to agree with the author’s position. 

 

Please note that two types of Perspective article feature in Clinical Investigation: 

 

Clinical Trial Perspective articles provide authors with the opportunity to discuss 

challenges and opportunities in clinical research and how new thinking in clinical trial 

methodology may influence future drug development strategies. 

 

Therapeutic Perspective articles allow the authors to discuss the rationale and 

potential clinical outcome of new drug classes and therapeutic approaches. 

 

Published example: 

Melvin GA, Gordon MS, Freake BM. Assessment of suicidal ideation and behavior in 

clinical trials: challenges and controversies. Clin. Invest. 2(3), 265–273 (2012). 

 

www.future-science.com/doi/pdf/10.4155/cli.12.10 

 

Aftab BT, Rudin CM. Therapeutic potential of Hedgehog signaling inhibitors in 

cancer: rationale and clinical data. Clin. Invest. 2(4), 371–385 (2012). 

www.future-science.com/doi/pdf/10.4155/cli.12.20   

Special Reports 

 

Special reports are short review-style articles that highlight a particular niche area, be 

it a specific emerging field, novel hypotheses or method. Articles are categorised as 

Special Reports at the discretion of the Editorial team. 

 

Published example: 

Bartlam B, Crome P, Lally F. The views of older people and carers on participation in 

clinical trials: the PREDICT Study. Clin. Invest. 2(3), 327–336 (2012). 

 

www.future-science.com/doi/pdf/10.4155/cli.12.4 

Research Articles 

 

Authors of original research must provide a supporting Cover Letter on submission 

briefly detailing: 

 

 relevance to the journal’s audience; 

 where the novelty in the study lies; 

 how the study advances understanding in the field; 

 direct and potential implications of the findings. 

http://www.future-science.com/doi/pdf/10.4155/cli.12.10
http://www.future-science.com/doi/pdf/10.4155/cli.12.20
http://www.future-science.com/doi/pdf/10.4155/cli.12.4
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Experimental details and data 

Only where a novel experimental procedure has been employed full details must be 

provided. Details of routine or previously reported experimental procedures should be 

provided via references only. 

Experimental procedures and/or data running to more than two Word document pages 

should be placed in a supplementary information file.  

 

Published example: 

Hennekens CH, Hetzel S, Pfeffer M et al. Low-dose enteric-coated aspirin does not 

inhibit thromboxane B2 and prostaglandin E2: data-derived hypothesis formulation. 

Clin. Invest. 2(7), 747–752 (2012). 

www.future-science.com/doi/pdf/10.4155/cli.12.56 

 

The journal publishes three categories of research article: 

Research Article 

Research articles should present novel work that makes a significant impact within the 

scope of the journal, and which represents an important advancement in knowledge or 

understanding. Routine or incremental work is not suitable for full research papers. 

Research should be reported succinctly; the inclusion of detailed background 

discussion is to be avoided. Supporting data or further experimental details can be 

submitted as Supplementary Information. If requested by the Editor or reviewers, 

authors should be able to provide additional relevant original data underpinning their 

research.  

Preliminary Communications 

Preliminary communication articles are intended for short reports of studies that 

present promising improvements or developments on existing areas of research. The 

significance and potential implications of the developments must be explicit.  

Methodologies 

Methodology articles should provide a clinical trial protocol for proposed or ongoing 

Phase I–IV clinical research. The protocol should describe both study design and 

rationale, indicating the importance of such research. 

Letters to the Editor 

Readers may submit Letters to the Editor, commenting on an article published in the 

journal. Where appropriate, Letters to the Editor will be sent to the author of the 

original article, who will have 28 days to provide a response for publication. 

http://www.future-science.com/doi/pdf/10.4155/cli.12.56
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Acceptance of Letters to the Editor for publication is at the discretion of the Editor 

and Editorial Board. 

 

 

The following list provides notes on the key article sections; authors should consult 

the ‘At-a-glance article formatting checklist’ to determine which sections are 

required for their submission. 

 

Title: Concisely and clearly conveys the scope/novelty of the article; not more than 

120 characters. 

 

Author(s) names and affiliations: Including full name, postal address, phone and fax 

numbers, and e-mail address. 

 

Abstract: Not more than 120 words; no references should be cited in the abstract. The 

abstract should highlight the importance of the field under discussion within the 

journal’s scope, and clearly define the parameters of the article.  

 

For all Research Articles only, the abstract must be structured into three sections: 

o Background: Brief overview of the context, purpose and novelty of the 

study. Trial registration details should be provided, where appropriate; 

o Results/Methods (for Research Articles and Preliminary 

Communications only): a summary of the clinical trial protocol and 

key findings; detailed discussion of data analysis should be submitted 

as supplementary information; 

o Methods (for Methodologies only): A succinct summary of the clinical 

trial protocol; 

o Summary: A summary of the main conclusions of the study and any 

clinical implications. 

 

Author photographs: Required for Editorials and Opinion articles only. The 

corresponding author plus one other author, if desired, can provide a suitable high-

resolution head shot for inclusion.  

 

Key words: Required for; a selection of 5-10 words that encapsulate the scope of the 

article.  

 

Body of the article: The article content should be arranged under relevant headings 

and subheadings to assist the reader.  

 

Future perspective: A speculative viewpoint on how the field will evolve in 5–10 

years’ time. 

 

Executive summary: Bulleted summary points that illustrate the main conclusions 

made throughout the article. 
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The use of figures and diagrams is encouraged wherever relevant. The author should 

include illustrations and tables to condense and illustrate the information they wish to 

convey. Commentary that augments an article and could be viewed as ‘stand-alone’ 

should be included in a separate box. All figures, tables and boxes should be 

submitted in an editable format. 

 

Figures, tables and boxes should be numbered consecutively according to the order in 

which they have been first cited in the text. All abbreviations used within them should 

be defined in the legend. 

 

If any of the figures or tables used in the manuscript requires permission from the 

original publisher, it is the author’s responsibility to obtain this. More details on 

obtaining permissions can be found in the copyright section below. 

 

 

Tables, figures and boxes larger than one A4 page will be included as online-only 

supplementary information. At the Editor’s discretion data or experimental details can 

also be included. 

 

 

o Authors should focus on recent papers; those older than 5 years should not be 

included except for an over-riding purpose. 

 

o Primary literature references, and any patents or websites, should be 

numerically listed in the reference section in the order that they occur in the 

text, using Arabic numerals placed in square brackets, e.g., [12]. 

 

o Any references that are cited in figures, tables or boxes that do not appear in 

the text should also be numerically listed in the reference section in the order 

that they occur in the text. 

 

Reference formatting 

 

All references should be formatted according to the house style given in the below 

examples: 

 

Journals 

 

Aftab BT, Rudin CM. Therapeutic potential of Hedgehog signaling inhibitors in 

cancer: rationale and clinical data. Clin. Invest. 2(4), 371–385 (2012). 
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Journal supplements 

 

Hauser RA, Freeman TB, Snow BJ et al. Long-term evaluation of bilateral fetal nigral 

transplantation in Parkinson disease. Arch. Neurol. 56(Suppl. 1), 179–187 (1999). 

 

Books 

 

De Groat WC, Booth AM, Yoshimura N. Neurophysiology of micturition and its 

modification in animal models of human disease. In: The Autonomic Nervous System 

(Volume 6). Andrews WR (Ed.), Harwood Academic Publishers, London, UK, 227–

289 (1993). 

 

Meeting abstracts 

 

Smith AB, Jones CD. Recent progress in the pharmacotherapy of diseases of the 

lower urinary tract. Presented at: 13th International Symposium on Medicinal 

Chemistry. Atlanta, GA, USA, 28 November–2 December 1994. 

 

Patents 

 

Pfiser Global R&D: US5623352 (2012). 

Cook N: US5623463 (2011). 

 

Please use the following formats for patent numbers issued by the World, US and 

European patent offices, respectively: WO1234567, US1234567, EP-123456-A. 

 

Reference annotations 

 

Authors can highlight 6–8 references that are of particular significance to the subject 

under discussion as “* of interest” or “** of considerable interest”, and provide a brief 

(1–2 line) synopsis. 

 

Example: 

 

 
 

1. Download the Future Science Reference Manager Style here. 

http://www.future-science.com/userimages/ContentEditor/1308649968656/FutureScience.os
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2. Once the file is downloaded to your desktop, copy the file to the appropriate folder 

in your program directory (usually located in C:\Program Files\Reference 

Manager\Styles). 

EndNote style 

Follow the instructions that are appropriate for your version of EndNote as listed 

below: 

Installing the style into EndNote X2 and later versions 

1. Download the Future Science EndNote style for references here (compatible with 

Mac EndNote 9). 

2. In Windows, or using your Macintosh Finder, browse to the location where you 

downloaded the style. Double-click on the style file to open it. It should open in the 

EndNote program. 

3. In EndNote, go to the "File Menu" and choose "Save as." 

4. Remove the word "copy" from the end of your style's name, and then click the Save 

button. 

5. Click on the "File Menu" and choose "Close Style." 

Installing the style into EndNote 8, 9, X, or X1 

1. Download the Future Science EndNote style for references here (compatible with 

Mac EndNote 9). 

2. Using Windows, or using your Macintosh Finder, browse to the location where you 

downloaded the style. Right-click on the style file and select Copy. 

3. Browse to your Endnote Styles folder. This will typically be in following location: 

Windows: C:\Program Files\EndNote #\Styles (Where # is the version number for 

EndNote)Mac OS: Applications\EndNote #\Styles (Where # is the version number for 

EndNote)Note: If you modify the EndNote preferences, you can set this to another 

location. To check this setting, go to the "Edit" menu or EndNote menu on the Mac 

and select "Preferences." Click on the Folder Locations option to see the custom Style 

folder location and modify as needed. Keep in mind that the default location for the 

Styles folder may cause problems when trying to save or edit in Windows Vista and 7 

with versions prior to EndNote X2. Please see this article for more information on this 

issue. 

4. Right-click in this folder and choose Paste. Your style should now be installed in 

the EndNote program. 

If you require further assistance or have any questions, please contact the Editor. 

http://www.future-science.com/userimages/ContentEditor/1308649963157/FutureScience.ens
http://www.future-science.com/userimages/ContentEditor/1308649963157/FutureScience.ens
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Authors should submit chemical structures in ISISDraw or Chemdraw formats. Please 

use the following conventions: 

 

 Always indicate stereochemistry where necessary – use the wedge and hash 

bond convention for chiral centers and mark cis/trans bonds as such; 

 Draw small peptides (up to five amino acids) in full; use amino acid 

abbreviations (Gly, Val, Leu, etc.) for larger peptides; 

 Refer to each structure with a number in the text.  
 

 

The journal website has functionality to support the Jmol viewer for the display of 

dynamic, 3D chemical and biological structures. We encourage authors to submit their 

relevant figures in any of the file formats supported by Jmol - including as 

MOL and CIF - to take advantage of this on-line functionality. More information on 

Jmol and the files supported by it, can be found here: http://jmol.sourceforge.net/ 

A published example can be viewed here: http://www.future-

science.com/doi/suppl/10.4155/fmc.10.282/suppl_file/figure6.htm 

For more guidance, please contact the Editor. 

 

 

If a figure or table has been published previously (even if you were the author), 

acknowledge the original source and submit written permission from the copyright 

holder to reproduce the material where necessary.  

 

As the author of your manuscript, you are responsible for obtaining permissions to use 

material owned by others. Since the permission-seeking process can be remarkably 

time-consuming, it is wise to begin writing for permission as soon as possible.  

 

Future Science is a signatory to the STM Permissions Guidelines produced by the 

International Association of Scientific, Medical and Technical Publishers 

(http://www.stm-assoc.org/). Permission is, or in the case of an express permission 

requirement should be, granted free of charge by signatory organizations, with respect 

to a particular journal article or book being prepared for publication, to:  

 

http://jmol.sourceforge.net/
http://www.future-science.com/doi/suppl/10.4155/fmc.10.282/suppl_file/figure6.htm
http://www.future-science.com/doi/suppl/10.4155/fmc.10.282/suppl_file/figure6.htm
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 Use up to three figures (including tables) from a journal article or book 

chapter, but:  

 not more than five figures from a whole book or journal issue/edition;  

 not more than six figures from an annual journal volume; and  

 not more than three figures from works published by a single publisher 

for an article, and not more than three figures from works published by 

a single publisher for a book chapter (and in total not more than thirty 

figures from a single publisher for re-publication in a book, including a 

multi-volume book with different authors per chapter).  

 Use single text extracts of less than 400 words from a journal article or book 

chapter, but not more than a total of 800 words from a whole book or journal 

issue/edition.  

 

Permission to go beyond such limits may be sought although in such instances the 

permission grant may require permission fees. Important: although permission may 

be granted without charge, authors must ensure that appropriate permission has 

nevertheless been obtained. Co-signatories of the permissions agreement can be found 

on the following website: http://www.stm-assoc.org/stm-permission-guidelines/.  

 

Please send us photocopies of letters or forms granting you permission for the use of 

copyrighted material so that we can see that any special requirements with regard to 

wording and placement of credits are fulfilled. Keep the originals for your files. If 

payment is required for use of the figure, this should be covered by the author.  
 

 


